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1 Introduction 
 

This quick guide should give you some basic information on how to use the DXL Logging features to 

troubleshoot the system.  

You should have some knowledge of the DXL Administrator Software before using this guide. 

Troubleshooting host/touchscreen operation may require some knowledge of the DXL Host Interface 

Specifications as well. 

2 Using the Logging Functions 

2.1 Functions of the Log Viewer 

2.1.1 Opening the Log Viewer 

You can open the Log Viewer window by clicking on the Logging 

button on the MicroComm DXL Administrator. This option lets 

you view the different types of events that are logged by the system 

and the log message content of each event. Once you press this 

button, the program displays a window with a menu from which 

you can select various options.  

2.1.2 Connecting to the Exchanges 

If the computer is not already connected to any Exchange(s) on the DXL 

system and you open the DXL Log Viewer then a Communications Link Setup 

window appears. In this window, use the Configuration option to connect to 

the Exchange(s) on the DXL system. This window is the same as the window 

that appears when you try to open the File Manager window through the DXL 

Configuration Editor. 

Note that if the computer is already connected to the Exchange(s) on the DXL 

then the program will skip the Communications Link Setup window and will 

directly display the Select Exchanges window, which is discussed next. 

When you click on the Connect button in the Communications Link Setup window, the 

Select Exchanges window appears with checkmarks beside all the Exchanges that the 

computer will try to connect to and download logs from.  You can select the check 

marks on the exchanges you want to view logs from (normally, all of the exchanges).  

2.2 Adjusting Settings in the Log Viewer Window 

An example Log Viewer window is shown below.  The Log Viewer window by default 

shows all log messages, which in a busy system can become too much information for 

efficient troubleshooting. 
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2.2.1 Setting the Auto-Download, Streaming, and Scrollbar Options 

First of all, set the status of the three icons in the top right corner of the window to match the above example.  

Make sure both the green circular arrow icon and blue circular arrow icon are “pressed in”, and the scroll bar 

icon is not “pressed in”. 

The function of the green circular arrow icon on the left is “Toggle Auto-Download Mode”.  If this option is on 

(“pressed in”), this means that if you scroll off the screen and there are no more logs that are already downloaded 

on the PC computer, that the Log Viewer will download logs from the DXL Exchange(s) to keep viewing. 

The function of the blue circular arrow on the right is “Toggle Stream Mode”.   If this option is on (“pressed in”), 

this allows the log Log Viewer to automatically show new log entries as they occur, otherwise you would need to 

“refresh” the logs to see new logs. 

The function of scrollbar icon on the very top right is “Toggle Scrollbar”.  If this option is on (“pressed in”), this 

allows you to scroll the logs with a scrollbar.  However, to know how long the scrollbar should be, the PC will 

need to read all of the logs, which can take a very long time.  Hence it is normally recommended to turn the 

scrollbar off. 

2.2.2 Setting the Column Format Settings 

Once you have matched the above example, you can adjust the ColumnFormat settings to only show the columns 

that you are interested in and how to display these columns. 

First of all, you can shorten the “Type” messages by using only icons in the “Type” column.   

Select the “Format” menu option, then “Column Settings…” 
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.  

From this screen you can select which columns to view, and select format of certain columns.  In this case, to 

show only icons, in the “Format” selector box across from the “Type” row, select “Icon”. 

2.3 Setting up Logging Filters 

2.3.1 Setting up Class and Type Filters 

Once you have matched the above example, you can set up log filters to allow easier troubleshooting by showing 

only log entries that you are interested in. 

To remove most of the debugging messages not necessary for field troubleshooting, you can also use the “Filter” 

option.  Select the “Filter” menu option then “Class and Type Filter” then “Modify…” 

 

This will bring up the “Class and Type Filter” window. 

This window allows you to select which logs you are interested in both by log 

type (whether it is a warning, error, normal information message, or detailed 

debugging message) and by the log class (the specific system functions you 

want to log). 

Check marks in this window indicate which types and classes of logs can be 

disabled.  A black check mark means that all logs of that type or class will be 

shown.  A grey check mark means that only some of these logs will be shown.  

An empty check box means that none of these logs will be shown. 

Log classes will have a plus sign next to them. This indicates that you can 

select sub classes within them individually. For example, since “System 

Activity” has a plus sign next to it, you can click the plus sign to see more classes of messages that are a sub-class 

of “System Activity” so you can individually select or de-select them. 
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For “types” of logs, for the most part, the “Debug” type of logs is usually only 

useful for Harding engineering staff.  You can turn off the debug message type 

for all message classes by first clicking the text “All” to select all classes, then 

un-check the “Debug” option to turn off debugging logs for all messages. 

However, there are some debug messages that are useful for installers and 

programmers, so to select only the useful ones, you can go further into the class 

tree. 

Click the plus sign next to “System Activity” and you will see further class 

information for System Activity.  

 

 

For some troubleshooting, it is useful to know when a station call request switch 

or other switch is pressed.  Select the check box next to “Switch Reporting”.   

This should change to a solid black check mark rather than a grey check mark, 

indicating that all logs will be selected for this class., as shown in the window 

on the left. 

You will notice on the right side of the window that the “Debug” option is now 

checked for this branch of the class tree.  

 

 

 

Another class of logs that you may want further information on is the “Host” 

messages.  Click on the plus sign next to Host.  Select the check mark next to 

Host to select all Host messages.  This will show all Host (PLC/Touchscreen) 

related messages; however there are some messages which are necessary only 

for Harding detailed diagnostics and would clog the logs up otherwise.  To not 

show these logs, click the plus sign next to Register Protocol, then select the 

text “Modbus TCP/IP” and un-check Debug, then select the text “Omron” and 

un-check Debug.  The completed Class and Type Filter should be similar to the 

window detailed to the right. 

When complete, click on the “OK” button to return to the main Log Viewer 

window. 

 

You can save a particular set of filter settings using the “Filter” menu option then 

“Class and Type Filter” then “Save As…” 

This will bring up a new window prompting you for a description you want to call this 

filter, with the bottom showing the filter settings already saved. 
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For further information, if you want to know what class a message is so that you can include or exclude it, first 

ensure that “Class” is checked under “Status Bar” of the Column Status Settings window.  If this is enabled, you 

can select the message in the main log viewer window and look at the information status bar at the bottom of the 

window which will show this information. 

This information bar also shows other selected items that were checked under “Status Bar” in the Column Status 

Settings window. 

In the below example, the selected grey Debug message is of class 

“Internal/Intercom Tasks”, the database version number of the DXL logging software on the DXL DCC was 

“2.1b2”, the configuration name was “VOIP LAB 1.0.1”, the “block number” of the log was 325, and the date 

that line of the log was taken was 2009-11-03. 

 

Once the filter settings above were applied, the following messages are shown. 

 

2.3.2 Setting up Message Text Filters 

The screen above still shows that there are a lot of messages in the logs which can prevent clearly seeing the 

system activity.  In these cases the logs are generated by the Modbus TCP/IP register protocol used by a 

touchscreen interface.  This interface polls the DXL system multiple times per second to determine new system 

activity.  This will generate a large number of logs which will always be present.  In this case, if all messages of 

“Host/Register Protocol” class were removed with the “Class and Type” filter, some useful messages will also be 

removed. 
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Hence we can use a new type of filter, “Message Text Filter” to remove only messages with a certain text 

message in them.  The messages we want to remove all have “single reg” in them so we can remove this register 

by excluding all messages which contain “single reg”. 

 

Select the “Filter” menu option then “Message Text Filter” then “Modify…” 

In this case, we want to exclude logs.  Check mark the “Exclude matching logs” button, 

then enter the text “single reg” in the “Hide Logs Containing” text box at the top and click 

“OK”. 

 

 

The resulting logs have more extraneous information, this time containing the text “queue reg”.  You can further 

refine the message text filter.   

Select the “Filter” menu option then “Message Text Filter” then “Modify…” 

Keep the “Exclude matching logs” button, checked, but since we are going to use a more 

complex filter as we are going to use multiple strings to exclude, click the  

“Regular expression (Perl 5 style)” check box as well.  The “regular expression” (search 

string) to include multiple strings is to use a vertical bar character (“|”) between strings.  

To exclude anything containing “single reg” or “queue reg”, enter the text 

 “single reg|queue reg” in the “Hide Logs Containing” text entry box at the top of the window, then click “OK”. 

The resulting log window is shown as follows.  This window now shows only normal system activity which is 

useful for troubleshooting. 
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Some of the log entries are too long for one line to display at this window size.  To see more logs and to make 

consistent viewing, you can stretch the window by clicking and dragging the resize portion of the window at the 

bottom right. 
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2.4 Using Logs to troubleshoot station call request buttons that do not work 

2.4.1 Log of normal system activity 

This section shows the normal course of activities for a typical call made using a touchscreen interface using the 

Modbus TCP/IP interface. 

 
 

A break down of the logs for a typical call such as the above call will consist of the following entries: 

 

1. A “call request” button is pressed at an intercom station 

 
 

2. The intercom system queues up a call request on the master or masters that it is designated to call into. 

 
 

3. The intercom system sends a call request command to the host (PLC or touchscreen) for the master or 

masters which have a host defined. 

 
 

4. The graphic panel or touchscreen will indicate that the intercom is calling in. 

 

5. The staff member at a control room master will answer the call by pressing the button or touchscreen 

icon of the intercom station 
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6. The host (PLC or touchscreen) will send a command to the intercom system to connect the control room 

master to the intercom station. 

 
 

7. The intercom system will connect the audio path from the master to the intercom station. 

Note that if the station was calling in to this master, the call will be removed from the call queue at this 

time as well. 

 
 

8. If the intercom station was calling in to this master, the intercom system sends a call request cancel 

command to the host (PLC or touchscreen) for the master or masters which have a host defined, 

indicating the call is answered and no longer requires attention. 

 
 

9. The intercom system sends a confirmation message to the host (PLC or touchscreen) indicating the audio 

path is established. 

 
 

10. The staff member will be in an audio conversation with the person at the intercom station. 

 

11. The staff member at the control room master will end the call by pressing the button or touchscreen icon 

of the intercom station or an “end call” button. 

 

12. The host (PLC or touchscreen) will send a command to the intercom system to disconnect the control 

room master from the intercom station. 

 
 

13. The intercom system will disconnect the audio path from the master to the intercom station 

 
 

14. The intercom system will send a confirmation message to the host (PLC or touchscreen) indicating the 

audio path is disconnected.  

 
 

2.4.2 Determining where to look in case a call request is not detected 

To identify where to look for a problem, you can look at the system logs while pressing the call request button on 

the station.  You can compare the resulting logs to the “normal operation” logs above to determine at what point 

is the call request not making it through. 

2.4.2.1 Check for a “call request switch detected” message 

First, examine the logs for the “call request switch detected” log when the call request button is pressed.  If this 

message is not present, then the system is not recognizing a button press.  This message, if present, would look 

similar to the following: 
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Be sure that the log filter does not filter out debug messages for “System Activity/Switch Reporting”, otherwise 

these messages won’t be shown even if the call request switch is pressed. 

If these logs are not filtered out, and you do not see any “call request switch detected” messages, then the 

intercom system does not recognize the switch, or the switch is not configured. You can determine the status of 

this station with the DXL Front Panel then selecting the exchange to look at. 

Go to the front panel of the DCC of the exchange that this station should be connected to, or use the Remote 

Front Panel by selecting “Diagnostics” from the main menu, then “View” and “Remote Front Panel…” 

Once at the front panel, press the “Status” button, then use the down arrow to select the box the station is on 

(“DCC”, “DCE1”, “DCE2”, etc.) and press ENTER.  Then use the down arrow to select the station card the 

station is on (“SCC1” or “SCC2”) and press ENTER.  You will then see a listing of stations on this card. You can 

use the down arrow to scroll the display until you see the station port you are interested in. 

If the station port has “---“ in the number column (such as station 

port 06 shown here) then the station is not configured, and the call 

button will not work. 

If the station has a number and name listed (such as station ports 01 

through 05 shown here), the station is configured.  The right column 

indicates the status of the station.  A 400 series station should 

normally have the status “I” (Station is working and Idle) such as 

the states indicated by ports 01 through 03.  A 300 series station 

should normally have the status “O” (the station switch wiring is 

Open, meaning the button is not pressed). 

Any other state usually means that the station is not working properly or not wired up.  Station port 04 here 

shows “O”, indicating the system detects an open circuit on this wiring pair. 

If the station indicates normal (“I” for a 400 series station or “O” for a 300 series station), if you hold down the 

button on the station and keep it held down, you should see the status change.  A 400 series station’s bottom 

button (button 2) should indicate “B” (switch B / switch 2) when pressed.  A 300 series station’s button should 

indicate “S” (shorted) when pressed.  If the status does not change when pressing and holding the button, the 

button is not working or the station is not working. 

You can use the troubleshooting guide for further information. 

If the station reads “B” but the “call request switch detected” log 

does not occur, verify that the DXL configuration has a switch 

associated with the station, and that the switch for that call request 

is switch 2 (if using the bottom right button on a 400 series station) 

or switch 1 (if using a 300 series intercom station). 

The configuration to the right indicates a properly configured button 

on a 400 series station.  If the button is configured for switch 

number “1”, then the intercom system is only looking for a button 

press on the top (“A”) button, which is not on a standard one button 

intercom.  In this case the configuration must be changed to have 

the Call Request function on switch number 2, not switch number 1. 
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2.4.2.2 Check for a “call request from station x has been sent to Master #y” message 

If the “call request switch detected” message is shown in the logs, next, examine the logs for the “call request 

from station x has been sent to Master #y” message following this.  This message, if present, would look similar 

to the following: 

 
If this message is present, check that this message is going to the master you expect the call request to go to.  If 

the message indicates that the call request is going to a master, but not the master it should go to, then you should 

check the configuration and correct the master it should be sent to, or if the facility has a flexible control system 

(sometimes called “task grouping” or “takeover mode”), verify that the touchscreen programming or take over 

functions are working properly. 

If this message is not present, then the system is not sending the call request to any masters. 

The usual cause for this behaviour is that the intercom system already has this call request queued on a master.  If 

it is already on a master queue, it will not show a message indicating it is queued to a master, nor will it re-send 

this message to a host. 

The below window shows an occurrence where pressing the call request button for station 2 does not generate a 

call request at the touchscreen. 

 

To determine what happened when the message was first put on the queue, you want to look backwards in the 

logs for that station to determine what happened at that time.  You can search the logs looking for this 

occurrence. 
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In this case, you want to look backwards until something happened when Station #2 (ICM #2) call request switch 

was detected. Use the “Search” menu item, then “Find…” (or press Control+F). 

This will bring up a “Find Log Message Text” window to search. 

Select the “Up” direction to search up towards older logs.  Enter a text string to 

search.  In this case we want to find call request switch detected messages for 

station number 2.  You could enter the full text string (“Station #2 (ICM #2) call 

request switch detected”), or you can use a “regular expression” with a wildcard 

in it so you do not have to type in the full station name, and just the number.  To 

match any characters, use the “.*” (dot star) characters.  In this case, type 

“Station #2.*call request switch detected”, then click “Find Next” 

This will take you to the previous occurrence of when the station 2 call request button was pressed.  You can use 

the menu item “Search” then “Find Again”, or press F3 to find the next occurrence.  Repeat until you see 

something happen after the Station 2 call request switch detected message. 

 

This tells you what happened when the call request switch was first pressed. 

In this case, when the switch was first pressed, the call request was queued, but no host messages were sent.  See 

the below section for what could cause this. 

2.4.2.3 If the master is controlled by a PLC, check for a host call request message 

If the “call request from station x has been sent to Master #y” message is in the logs, examine the logs for a host 

message indicating the call request was sent to the host.switch detected” message is shown in the logs, next, 

examine the logs for the “call request.  This log will vary depending on the host.  If the system is using a text host 

the message will indicate 

‘DXL sent “Icrq <master> <station>” to Host Port #h (host h name)’. 

 
 

or if the system is using a Modbus or Omron register based host, the message will indicate the host port number, 

master number, register number and a 5 register block starting with an address, with the first register in the block 

being 1 (Icrq) and the contents of the 5 block registers being ‘1 <master> <station> 0 0’, such as the below 

command. 

‘Host Port #h (host h name) read Master #m (master name) status reg@r: 1 m s 0 0’ (polled host) 

 
or 

‘Host Port #h (host h name) wrote status reg@r: 1 m s 0 0’ (peer to peer host) 
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If there is no host call request message, then either the host is not configured properly (I.E. the master is not 

associated with a host, or the host is not configured), or the host (touchscreen/PLC) is not communicating with 

the DXL system. 

2.4.2.3.1 Example logs when host is not communicating to the DXL system 

The following log screen shows a complete set of logs when a host is not communicating with the DXL system. 

 
 

Note that the first time the call request switch is pressed, the “call request switch detected” message was shown 

and the call request was sent to masters 1 and 2, but no host messages were sent. 

Subsequently when the call request switch was pressed, only the “call request switch detected” message shows in 

the logs, as the DXL system already had the call request in the system queue. 

 
 

Also of note in these logs is that the touchscreen in this example was able to control the intercom system and 

make a call by writing a value into the master’s command register, and when the station was called, that the call 

request was removed from the master queues. 
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In this case, the touchscreen software was a polled Modbus system, but the touchscreen software was not set to 

poll the master status registers. 

2.4.2.3.2 Example logs when host is communicating to the DXL system but the 
message is lost 

Another possibility is that the PLC or touchscreen software did receive the message, but did not process it.  This 

is indicated by the call request message being detected, the call request being queued on the master, and the 

message being read by the host, but not showing up on the touchscreen.  The activity looks completely normal in 

this case, as the intercom system completely processes the message, but it is lost in communications or by the 

PLC or HMI software. 

 
This could occur when: 

1. A PLC or Data Acquisition Server (DA Server) is polling the registers, but the logic in the PLC or 

Touchscreen software is not processing the registers, or is not acting on the registers (perhaps due to the 

logic not executing under certain conditions) 

2. A PLC or DA Server is polling the registers, but the logic in the PLC or Touchscreen software does not 

process the registers fast enough.  For example, if a Wonderware DA Server is set to poll the master 

status registers twice per second, but the logic to process the status registers only executes once per 

second.  In this case if two call requests happened at almost the same time, the first call request would be 

polled and the logic will start processing it, then the second call request would get polled, but not 

processed since the logic is still processing the first register.  In this case the DA server could be set to 

poll slower, or the processing logic can be set to be executed more often. 

3. A PLC or touchscreen interface is examining the wrong registers for the call request status information. 

 

3 Common Logging Messages Useful for Troubleshooting 
The following log messages and filters used to search for them may be useful for troubleshooting. 

The first line indicates the search string you can use to find these errors, the second line shows a sample error 

message line. 

Unless otherwise noted, the search string uses regular expressions. 

3.1 Normal system activity 

Station #<station>.*call request switch detected 

Station #1285 (104B-H) call request switch detected. 

Call request switch was pressed. 
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Call request from Station #<station>.*has been sent to Master #<master> 

Call request from Station #1285 (104B-H) has been sent to Master #1 (Central). 

Call request was queued to a master station 

 

Master #<master>.*dialed.*Station #<station> 

Master #1 (Central) dialed (to call) Station #1285 (104B-H). 

Master station has initiated a connection command to call intercom station 

 

Call request from station #<station>.*has been removed from Master #<master> 

Call request from station #1285 (104B-H) has been removed from Master #1 (Central). 

 Call request has been removed from a master station queue 

 

Master #<master>.*is establishing call to Station #<station> 

Master #1 (Central) is establishing call to Station #1285 (104B-H). 

 Master is starting the connection to an intercom station 

 

Call from Master #<master>.*to Station #<station>.*has been established. 

Call from Master #1 (Central) to Station #1285 (104B-H) has been established. 

 Audio connection from master to station is connected 

 

Master #<master>.*is ending its call to Station #<station> 

Master #1 (Central) is ending its call to Station #1285 (104B-H). 

 Master is ending the connection to an intercom station 

 

Call from Master #<master>.*to Station #<station>.*has been ended. 

Call from Master #1 (Central) to Station #1285 (104B-H) has been ended. 

 Audio connection from master to station is disconnected 
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3.2 Normal host activity 

 

Host Port #<host>.*read Master #<master>.*status reg.*1 <master> <station> 

Host Port #1 (Modbus Host) read Master #1 (Central) status reg@105: 1 1 1285 0 0. 

 PLC host master received call request from station 

 

Host Port #<host>.*wrote Master #<master>.*command reg.*7 <master> <station> 

Host Port #1 (Modbus Host) wrote Master #1 (Central) command reg@100: 7 1 1285 0 0. 

PLC host sent command to connect a master to a station 

Host Port #<host>.*read Master #<master>.*status reg.*2 <master> <station> 

Host Port #1 (Modbus Host) read Master #1 (Central) status reg@105: 2 1 1285 0 0. 

 PLC host master received call request cancel from station 

 

Host Port #<host>.*read Master #<master>.*status reg.*15 7 <master> <station> 

Host Port #1 (Modbus Host) read Master #1 (Central) status reg@105: 15 7 1 1285 0. 

 DXL completed master to station connection requested by host 

 

Host Port #<host>.*read Master #<master>.*status reg.*7 <master> <station> 

Host Port #1 (Modbus Host) read Master #1 (Central) status reg@105: 7 1 1285 0 0. 

 DXL completed master to station connection 

3.3 Permission error 

Rejected because *. is not on .* permission list 

 “Ical <master> <station>” rejected because <station> is not on <master>’s permission list. 

The indicated master is not permitted to call the indicated intercom.  To correct this you need to change 

the configuration in the DXL Administrator.  Select “Configure:Masters”, double click the master 

number, go to the “Permissions” tab, select Function “Call Station”, and add the stations that this master 

should be allowed to call. 

Alternatively, you can use select “Configure:System”, go to the “Master Operations” tab, and check-mark 

the “Disable Host command permission checks” check box to make all host-controlled masters able to 

call any intercom. 

Similar messages will be shown for master to master call permissions, master to page zone permissions, 

etc., with the corrective action being to change the appropriate permission settings for that master. 

 


